
CMSTrainingNotesFeb2013.docx  Page 1 of 49 

Terminal Four (T4) Site Manager 
 

Contents 
 
Terminal Four (T4) Site Manager ............................................................................... 1 

Contents ................................................................................................................. 1 

Login ....................................................................................................................... 2 

The Toolbar ............................................................................................................ 3 

An example of a University of Exeter page ............................................................. 5 

Add a section .......................................................................................................... 6 

Add content to a section ......................................................................................... 7 

Edit and modify existing content in a section ........................................................ 11 

Approving content ................................................................................................. 13 

Publishing of approved content ............................................................................ 14 

The content editor toolbar ..................................................................................... 15 

Tables ................................................................................................................... 17 

Adding Links ......................................................................................................... 19 

Moving Sections ................................................................................................... 25 

Drag and drop method ...................................................................................... 25 

Menu method .................................................................................................... 25 

Deleting a Section................................................................................................. 28 

Using Templates ................................................................................................... 30 

www Page with no Feature Image .................................................................... 30 

www Image with Caption ................................................................................... 31 

www Page ......................................................................................................... 31 

www Page with Feature Image ......................................................................... 32 

Re-using Existing Content (Mirror, Duplicate, Move) ............................................ 32 

Re-ordering Content in a Section ......................................................................... 34 

Copying Whole Branches ..................................................................................... 36 

Media Library ........................................................................................................ 39 

Uploading Media ............................................................................................... 39 

Adding Media as Content: Document Links ...................................................... 42 

Adding Media as Content: Images .................................................................... 43 

Guidelines on Images in the Media Library ....................................................... 45 

Using the Pixlr photo editor to resize images ........................................................ 45 



CMSTrainingNotesFeb2013.docx  Page 2 of 49 

Login 
 
The login page is available at: 
https://content.exeter.ac.uk/terminalfour/SiteManager 
 

 
 
Enter your regular university username and password. 
 

� You can also access SiteManager by keying in 
https://content.exeter.ac.uk and selecting SiteManager from the 
list of options. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This will open the ‘Show site structure’ screen.  This is the site structure, where you 
will see the parts of the site available to you listed.   
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This training is aimed at ‘Moderators’. The type of user is shown in the top right hand 
corner of the screen. From the bar in that top right hand you can also Logout of Site 
Manager, as well as increase and decrease the size of the text in the interface. 
 

 

The Toolbar 
 
The images below show the menus available as a ‘Moderator’ 

 
On the Help menu, the ‘Submit Suggestion’ and ‘Report an Error’ options send 
information direct to Terminal Four. DO NOT USE THESE features. If you have 
errors or suggestions to report, then you should submit these to your local Web 
Marketing Officer or to the central Web Team via the IT Helpdesk. 
 
 
 
 
 
 
 
 
 
 
 

Increase the size of the text in 
the Site Manager interface. 

Shows your user name and 
the type of user you are. 

Logout of Site Manager 
here. 
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The Add, Modify and Delete options from the Section menu are also available 
through the hierarchy dropdown menu  
 

 

 
 
 
 
 
 
 
 



CMSTrainingNotesFeb2013.docx  Page 5 of 49 

An example of a University of Exeter page  

 
 
The content of this page in Site Manager is shown below.  
 

 
 
The site structure – finding this page: 
 

Image with 
caption  
These are always 
positioned in the 
same place with 
shaded caption 
below 

Breadcrumb 
Trail 
This is 
automatically 
generated from 
the site structure 

Navigation 
Menu 
This is 
automatically 
generated from 
the site structure 

Page Heading  
This top heading 
is always 
‘Heading 1’ 
formatting is 
automatically 
generated 

Content  
The main text on 
the page can 
usually be 
created as one 
piece of content, 
or as multiple 
pieces if 
paragraphs need 
to be mirrored to 
other pages. 

Sub-headings  
These should 
always be used in 
order; the top two 
here will be 
‘Heading 2’, and 
the three 
subheadings 
about applying 
‘Heading 3’ 
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Add a section 
 
Click on the arrow and select ADD SECTION 
 

 
 
This will display the following screen. 
 
Complete the ‘Name’ box.   
 

� The name will appear as a menu item, as part of the title of the 
website and in the address of the section, so keep it short but 
relevant.  Generally you should use ‘sentence case’ for your 
section names ie only capitalise the first word. 
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Enter a shortened name in the Output URI field – this is the name that will be shown 
in the URL. 
 
Leave the other fields as they are. 
 
Click ‘ADD’, which is available from either the top or bottom of the page; this will 
return you to the site structure screen.  

Add content to a section 
 
From the site structure page, click on the menu arrow next to the section in which 
you want to add content. 
 

 
 
Click  ‘ADD CONTENT’ 
 
You will then be required to select the appropriate template. 



CMSTrainingNotesFeb2013.docx  Page 8 of 49 

 
 
The template is shown as below: 
 

 
 
Complete the ‘NAME’ and ‘HEADING’ fields.   
 
Templates are covered in more detail later in this document.  See ‘Using Templates’. 
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Type your text into the MAIN BODY template. Paragraphs and line breaks work in 
the same way as Microsoft Word (use the ENTER key for a paragraph break and 
SHIFT+ENTER for a line break)  
 
Click the ‘PREVIEW’ button to see how your content will appear on the web; your 
page will be displayed in a new browser window. 
 

 
 

� Note that the left hand menu bar and the breadcrumb trail have 
been produced. 

 
When you are satisfied that the page is as required, click on the ‘ADD’ button at the 
top or bottom of the content template page. 
 
You will return to the Modify Content window, where the newly added content will be 
displayed. 
 
To add additional content to this section, click ‘ADD CONTENT’ and repeat as 
before. 
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� Note the version number.  As this is new content that has been 
added, the version is 0.1.   
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Edit and modify existing content in a section 
 
Navigate to the Section that you wish to edit or modify. 
 
Click on the arrow next to the section containing the content to be edited. 
 

 
 
Select ‘MODIFY CONTENT’ 
 
You will be returned to the Content tab in your selected section. 
 

 
 
 
You can either click the name of the content you want to edit, which will take you 
straight to the editing screen, or  click on the arrow next to the content to be edited. 
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Select ‘MODIFY’ 
 
This will return you to the content editing screen. 
 

 
 
After editing or adding content, ‘PREVIEW’ and then ‘UPDATE’ to save your work.  
 
You also have the option to ‘SAVE TO DRAFT’ if you don’t want your content 
approved for publication yet and intend to come back to it and finish your updating 
later. This is a useful option if you have a lot of amendments to carry out on a page 
and you don’t want to risk it being approved for publishing before you are ready. 
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Approving content 
 
If you are not already inside a piece of content, g
before. 
 
Click ‘Update and Approve’ from the ‘Update’ drop

 
Your content will now be approved and will publish out to the live site with the next 
scheduled transfer from the CMS.
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If you are not already inside a piece of content, go back into Modify Content

‘Update and Approve’ from the ‘Update’ drop-down menu: 

Your content will now be approved and will publish out to the live site with the next 
eduled transfer from the CMS. 

The status of your content is now 
shown as ‘Approved
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o back into Modify Content as 

 

Your content will now be approved and will publish out to the live site with the next 

 

Click the down arrow 
next to ‘Update’ and 
then click ‘Update and 
Approve’ from the 
menu. 

The status of your content is now 
Approved’. 



CMSTrainingNotesFeb2013.docx  Page 14 of 49 

 
 
 

� Note: Moderators can approve their own content, depending on 
how the site they are editing is set up. But you won’t be able to do 
this if your section is subject to a workflow, which means someone 
else reviews all updated content before publishing, so they will 
have the approval rights on all content in that area and have to 
approve your updated content for you. If your content is subject to 
a workflow, there will be no ‘Add and Approve/Update and 
Approve’ option displayed for that content. Workflows are not 
widely used on our site, but if this is the case, your Web Marketing 
Officer can explain to you how workflow works in your area. 

 
 

Publishing of approved content 
 
Once your content is approved it will be published on the live site with the next 
scheduled transfer. These take place twice-daily, first thing in the morning and also 
in the early evening. 
 
So any content that is approved during the day should be on the live site by the 
following morning. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



CMSTrainingNotesFeb2013.docx

The content editor toolbar

The content editor toolbar is similar to that seen in word processing applications.  
The buttons that are available for use will be in colour, they are 
available. 
 

 
Bold 

 
Italics 

 

Formatting Style (eg 
Paragraph, Heading 1, 
Heading 2, etc...)

 
Cut 

 
Copy 

 
Paste 

 Paste from Plain Text

 
Select All

 

Insert Web Link (greyed 
out until you highlight text 
for linking)

 

Remove link (greyed out 
until you highlight link text 
for removing link)

 Insert/edit anchors

 
Edit HTML Source

 
Find 

 
Find/Replace

 
Numbered Items/ Bulleted 
Items 

 
Decrease Indent/ Increase 
Indent 

 
Undo/Redo

 
Horizontal rule
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The content editor toolbar 

The content editor toolbar is similar to that seen in word processing applications.  
The buttons that are available for use will be in colour, they are grey

 
Abbreviation

 
Subsc

Formatting Style (eg 
Paragraph, Heading 1, 
Heading 2, etc...) 

 
Insert special 
character

 
Enlarge Editor (Full 
screen)

 
Insert Section Link

 
Insert Content Link

Paste from Plain Text 
 

Insert Item from Medi
Library

Select All 
 

Spell Check

Insert Web Link (greyed 
out until you highlight text 
for linking)  

Remove All Formatting

Remove link (greyed out 
until you highlight link text 
for removing link)  

Insert New Table

Insert/edit anchors 
 

Table

Edit HTML Source 
 

Table cell properties

 
Insert New Row 
Before/After

Find/Replace 
 

Delete Row

Numbered Items/ Bulleted 
 

Insert New Column 
Before/After

Decrease Indent/ Increase 
  

Delete Column

Redo 
 

Merge Cells/ Split 
Cells 

Horizontal rule   
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The content editor toolbar is similar to that seen in word processing applications.  

greyed out when not 

Abbreviation 

Subscript/Superscript 

Insert special 
character 

Enlarge Editor (Full 
screen) 

Insert Section Link 

Insert Content Link 

Insert Item from Media 
Library 

Spell Check 

Remove All Formatting 

Insert New Table 

Table row properties 

Table cell properties 

Insert New Row 
Before/After 

Delete Row 

Insert New Column 
Before/After 

Delete Column 

Merge Cells/ Split 
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To return to the Site Hierarchy from the Section and Content Screens, click on the 
arrow on the left hand side of the window.  
 
When you are in a section the Site Hierarchy is viewable in the left hand column. It 
can be toggled either on or off by clicking the left and right arrows at the top of the 
hierarchy. You can also drag the right hand side of the structure column to make it 
wider if you wish.  
 
 

 
 

  
You can return to the full width Site Hierarchy window by clicking the arrow on the 
left hand side of the Section tabs. 
 

  
� Note: The site structure does not appear when you are actually 

editing a piece of content, allowing you the full width of the 
screen to work in. 

 
You can also click the T4 logo in the top left of the red page banner in any window to 
go back to the full site structure, but DO NOT DO THIS whilst editing a piece of 
content, as you will lose any changes you’ve made and not saved, since it doesn’t 
prompt you to update or add unsaved content.  
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Tables 
 
In the template editing screen, click on the 
 

 
 
This will display the following window:
 

 
You don’t need to fill in all of the fields in th
to elements of table style that a
applied automatically to your table. You should fill in the following
tab: 
 

1. Columns: The number of columns you need in your table
 

2. Rows: The number of rows you need in your table
 

3. Table caption (if required): 
When people look at a table they quickly scan it to get some sense of what 
information it conveys
using screen readers, this kin
accompanying a table 
because, unlike a separate heading above the table, it is attached to the table 
itself in the underlying code
containing data that’s illustrating a point, such as statistics on student 
numbers, cost of living, etc.
 

4. Make first row/column a header: T
display with a different background colour, eg:
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In the template editing screen, click on the ‘INSERT TABLE’ icon: 

the following window: 

 

You don’t need to fill in all of the fields in this popup window, as many of them
to elements of table style that are already handled by the central stylesheet and 
applied automatically to your table. You should fill in the following on the General 

he number of columns you need in your table 

he number of rows you need in your table 

n (if required): You don’t have to have a caption on every table. 
When people look at a table they quickly scan it to get some sense of what 

conveys, but for users who perhaps can’t see so well or who are 
readers, this kind of scanning is more difficult. S

accompanying a table can give them a quick idea of what the table contains
because, unlike a separate heading above the table, it is attached to the table 
itself in the underlying code. So it is good practice to include one
containing data that’s illustrating a point, such as statistics on student 
numbers, cost of living, etc. 

ake first row/column a header: This makes your header row or column 
display with a different background colour, eg: 
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is popup window, as many of them apply 
re already handled by the central stylesheet and 

on the General 

don’t have to have a caption on every table. 
When people look at a table they quickly scan it to get some sense of what 

, but for users who perhaps can’t see so well or who are 
So a caption 

give them a quick idea of what the table contains 
because, unlike a separate heading above the table, it is attached to the table 

one for tables 
containing data that’s illustrating a point, such as statistics on student 

his makes your header row or column 
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Complete the information required and click ‘OK’. 
 
Your table will be placed in the ‘Main Body’ section of the template. 
 

 
 
The grey shaded cells indicate that these are heading cells. 
 
Enter your text into the cells. 
 

� Note: your table will have a space in each cell.  You should 
delete this space character when entering text into the table.  If 
the space is left, particularly before entering text, the table will be 
misaligned. 

 
Your table will resemble that below: 
 

 
 
Click on the ‘PREVIEW’ button to view your table.   
 
You will see that the table has been automatically formatted. 
 

This row is marked as a header 
row and appears with grey 
shading and bold text. Colours 
vary depending on the section of 
the site where the table appears. 
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Return to Site Manager and click ‘ADD’ to save your work.

Adding Links 
 
Links to other websites 
 
On the content template page, highlight the text to be linked.
 

 
Click on the ‘INSERT WEB LINK’ 
 

 
 
Type in, or paste, the full URL of the web page you 
 
You do not need to enter a Title, but can do if you wish
about where the link goes to 
information, which most of the time it
your page hovers their mouse over the link.
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Return to Site Manager and click ‘ADD’ to save your work. 

On the content template page, highlight the text to be linked. 

EB LINK’ button 

Type in, or paste, the full URL of the web page you wish to link to. 

You do not need to enter a Title, but can do if you wish to provide a little more detail 
about where the link goes to – but only if your link text doesn’t provide eno
information, which most of the time it should. The title will appear when the user of 
your page hovers their mouse over the link. 
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provide a little more detail 
only if your link text doesn’t provide enough 

The title will appear when the user of 
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The ‘Target’ determines where the link opens up, ie in the current window, or as a 
new window. Best practice is that it opens in the existing window.  A target of ‘Open 
in this window/frame’ will use the template’s default value, so this can be left as is.  
 
Avoid opening links in new windows unless the content is providing help text for a 
something a user is doing on an existing page, or they are filling in an online form 
and leaving the page they are in will interrupt the flow of that process. If a link is 
designed to open in a new window, this should be specified by selecting ‘_blank’. 
You should also indicate to the user of the page that the link opens in a new window 
by putting ‘(opens in a new window)’ or ‘(new window)’ in brackets after the link. 
 

 
 
Click ‘OK’. 
 
The link is now shown as a hyperlink: 
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Adding links to other SECTIONS in your website 
 
On the content template page, highlight the text to be linked. 
 
Click on the ‘INSERT SECTION LINK’ button 
 

 
 
A window of the site will appear: 
 

 
 
Navigate through the folders to find the required area of Site Manager. 
 
Click on the section you wish to link to. 
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Adding links to other CONTENT in your website 
 
On the content template page, highlight the text to be linked. 
 
Click on the ‘INSERT CONTENT LINK’ button 
 

 
 
A window of the site will appear: 
 

 
 
Navigate through the folders to find the required area of Site Manager. 
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And click on the section you wish to link to. 
 
A new window will appear showing the content of that section: 
 

 
 
Click on the required content.  This window will disappear, returning you to the 
content template page, with the link completed: 
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Your page can then be previewed: 
 

 
 
Return to the content template window and click ‘ADD’ to submit your content. 
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Moving Sections 
 
You can move a section in Site Manager. You can do this via the section drop-down 
menu, or you can drag-and-drop sections in the structure. 
 

Drag and drop method 
You need to be in the main site structure window to use this – it doesn’t work when 
the structure displays to the left of a section you are in. 
 
To drag and drop, click and drag the relevant section into another section: 
 

 
When you have located it over the section you want to move it to, release the mouse 
button  
 

 
 
and click OK. 
 

Menu method 
 
Click the arrow next to the Section you wish to move 
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Click ‘Move Section’ 
 
Then, in the structure that displays, click your mouse where you want the section 
moved to – in the image below, Archive is shown with yellow highlighting as this is 
where the section is being moved to. 
 

 
 
To change the order of Subsections, click Modify Section on the top level Section. 
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Click on the Subsections Tab 
 

 
 
 
Use the Move buttons to move your Subsection. 
 

 
 
Click Save Changes 
 
Return to the Site Structure using the UP Button 
 

 
 
 
 
 

Move to the Top 

Move to the Bottom 

Move up  

Move down 
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Deleting a Section 
� Note: Depending on what section of the site you are working in, 

some areas require that you don’t delete sections or content, but 
instead move any unwanted ones into a Pending section, to 
avoid losing them when content is recycled, so it is available 
should it need to be reused. If you want to keep content or 
sections to reuse at a later date, DO NOT MAKE THEM 
INACTIVE by deleting them. Instead move approved content 
into a Pending section set up for that purpose, from which 
nothing will be published to the live site. Your College or Service 
Web Marketing Officer can advise you on this. 

 
To delete a Section or Content, click on the Section or Content Arrow and select 
DELETE. 
 

 
 
You will receive a message checking that you really want to delete the Section, click 
OK. 
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You will see that that Section is now red in colour. It will no longer show on the 
website, but it will still be visible in your Site Structure until the Web Team clear the 
deleted items, which occurs every Friday afternoon.  So before deleting sections and 
the content they contain, be very sure that you aren’t going to need it again. 
 
If they have not been cleared from the recycle bin, deleted items can be reactivated 
by clicking on the down arrow for your Section and clicking MODIFY SECTION. 
 

 
 
The Status should then be changed to Pending or Approved (depending on your 
level of authorisation). 
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Using Templates 
 
We have used the template page previously, when first adding content
‘www Page with no Feature 
 

There is a range of templates available, but the general ones you will find yours
mostly using are those listed above
page elements, depending on how your content needs to 

www Page with no Feature Image
This template is used as the 
with a heading and a body section
 

 
It has a heading and a body section

www Page with no 
Feature Image 
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We have used the template page previously, when first adding content
eature Image’ was used. 

There is a range of templates available, but the general ones you will find yours
using are those listed above. They each provide different page layouts and 

page elements, depending on how your content needs to be arranged

Page with no Feature Image  
is used as the main page style for most straightforward

a heading and a body section, such as the example below: 

and a body section.  
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We have used the template page previously, when first adding content where the 

 
There is a range of templates available, but the general ones you will find yourself 

. They each provide different page layouts and 
be arranged. 

straightforward page content 

 

www Image with 
Caption 
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Only use this template for your first or only piece of content, as it gives your page its 
top heading (heading 1), of which you only want one per page. Never use this 
template more than once in a section. 
 
You can add subheadings and paragraphs, bulleted or numbered lists and links in 
the body section of this template. 
 
Unless you need an image, or content that requires a different template to style it, or 
you have to mirror a small part of your page content to another page, you do not 
need to create a new piece of content to add more text to an existing page – you just 
modify the existing www Page with no Feature Image content in the body section.  

www Image with Caption 
 

‘Image with Caption’ is used to add content which is an image with a caption off to 
the right of your main content. 
 
This template can be used within the same section as the www Page with no 
Feature Image template. It does not matter in which order this template occurs in the 
content list, it will always display to the right of your main content. 

www Page 
 

‘Page’ is used to add text content to a page  
• where you want to separate it out from main text to be able to mirror it to 

another section,  
• where you have to add text after existing mirrored content,  
• or following other content that uses a different template from the standard 

ones where you don’t want a top heading, eg after a quote panel: 

 

Quote/ profile panel  

www Page with no Feature Image  

www Page 
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www Page with Feature Image 
 
‘Page with Feature Image’ is used, in the main, for title/introductory pages on some 
sites and puts a wide feature image above the heading and main text. You may not 
need to use this depending on the overall design of the particular pages you are 
maintaining. 

 
 

Re-using Existing Content (Mirror, Duplicate, Move) 
 
Existing content can be reused in 3 different ways: 
 

Mirror Replicates content held elsewhere.  When changed in one place, all 
other instances of the mirrored content are updated. 

Duplicate Content is replicated as it is.  Once duplicated the content stands 
alone and will require updating separately from its original. 

Move Content is moved from one place to another.  It appears in only one 
place. 

 
Navigate to the content to be re-used. You can navigate to the Section it is in and 
select ‘Modify content’ from the right hand drop-down menu to arrive in the Content 
tab. 
 
Click the arrow to the right of the content. 
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Select Mirror, Duplicate or Move. 
 

 
 
You will be returned to the main Site Structure page where you should navigate to 
the section to which the content will be Mirrored, Duplicated or Moved. 
 
Click on the Section 
 
Site Manager will then open up the Content page for the original content.  As it has 
been mirrored, there is a snowflake image next to the content name.  Hovering over 
the snowflake shows where the content is mirrored. 
 

 
 
Navigate to the section where the content was mirrored to; this displays the content, 
once again with the snowflake image, informing users that this content is mirrored. 
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Re-ordering Content in a Section 
 
Content can be reordered within a section using the Move arrows. 
 

 
 
Site Manager View 
 

 
 
 
 

Move to the Top 

Move to the Bottom 

Move up  

Move down 
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Web Preview 
 

 
 
 
Move content, using the arrows: 
 

 
 
Click ‘SAVE CHANGES’ 
 
The content has then been re-ordered when previewed. 
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Copying Whole Branches 
Sometimes you may want to copy a whole branch of a website (this will include all 
the sections and therefore its structure).  When copying you can choose whether or 
not to include the content itself. 
 
Click on the arrow next to the Section you wish to copy and click DUPLICATE 
BRANCH from the menu 
 

 
 
 
You can choose to ignore the content and simply copy the structure of the branch, or 
duplicate or mirror the content.  As before, if you mirror the content, any changes you 
make will be made in the original; if you duplicate, the changes you make in your 
section, will only affect that section. 

 
Select where you want to duplicate the branch by clicking on the Select button, a 
new window will open, showing your site structure. 
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Click the section where you want to copy the branch to. 
 

 
 
The details of the Section being copied into are then shown; if this is incorrect it can 
be corrected by clicking on the Change link. 
 
Click the Duplicate button at the bottom of the screen. A ‘progress’ window shows 
you how many sections are being duplicated. 
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The full branch will then be duplicated in the new location. 
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Media Library 
 
Any image, document or other form of media to be included in content must first be 
uploaded into the Media Library. 
 

Uploading Media 
 
From the Site Structure page, select Media Library from the Content Menu: 
 

 
 
 
Navigate to where the file should be uploaded: 
 

 
 
Click on the Add Media button: 
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Complete the fields providing the Name of the Document or Image (note that the 
name you give a document will be used for link text in links to that document, 
although this can be edited once you add it to your content – see 
www.exeter.ac.uk/staff/web/sitemanager/guides/documents/linking/), and a 
Description. 
 
Then use the Browse button next to ‘Media’ to find the media file you want to upload 
from your hard drive. Site Manager works out from the file extension of your 
uploaded file (eg .jpg/.pdf/.docx) what possible media Types are appropriate, and 
these will be displayed next to ‘Type’ above the Media field.  
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In many cases there will only be a single type available so you will not have to 
choose an option. However, if there is more than one 
either ‘Image’ type or ‘Media path’ type depending on what template it is 
used in - then you will have to select the appropriate type
using an image in an ‘Image with Caption’ template, 
‘Image’, so choose this option.
 
Note : If you should choose the wrong media type when adding media, you should 
Add it anyway, and then go back in to 
drop-down menu of media typ
Update the file. 
 
Click ‘image’ as the media type
 
If you have a thumbnail image for the media you may also upload this, otherwise T4 
will create one for you. 
 
You don’t need to complete any other fields.
 
Click on the Add button. 
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In many cases there will only be a single type available so you will not have to 
ver, if there is more than one - for example, 
edia path’ type depending on what template it is 

then you will have to select the appropriate type from those listed
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Adding Media as Content: Document Links 
 
Locate your cursor where you want to link to your media to appear and click on the 
‘Insert Item from Media Library’ icon. 
 

 
 

 
 
Navigate to where the media item is saved and click on its name. A popup window 
opens showing the media item you have clicked. Click ‘Select’. 
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The name of the media item will then be displayed as a link. 
 

Adding Media as Content: Images 
 
Images should only be used on University web pages using appropriate templates.  
The most commonly available is the ‘Image with Caption’ template, although there 
are others available (eg staff contact pages etc…)  
 
Click on the ‘www Image with Caption’ link.  This will open up the template. 
 

 
 
Give the image a name. 
 
Click ‘SELECT’ adjacent to Image. 
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Browse through the categories until you find the image you’re looking for. 
 
Once you have found the required image, click on it and a popup window will display 
it as below.  
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Click SELECT and the path to your selected image will appear in the template’s 
Image field. 
 
Add your caption text. 
 

 
 
Click ‘ADD’ to save. 
 

� Note: It is not possible to preview images from the Media Library 
in content you have not yet Added. When you have put your 
image into a piece of Image with Caption content, ‘ADD’ the 
content in order to save it, and then go back in by clicking 
MODIFY. Now you will be able to Preview it as normal. 

 

Guidelines on Images in the Media Library 
 
Preparing images for use on the web: image size 
 

� Note: There is an ‘Image variation’ feature available in the Media 
Library, which you may notice when you go to select an image to 
bring into your Image with Caption template. Unfortunately, this 
feature really does not work well enough for us to recommend 
you use it. So we advise you not to try it, but to use pixlr.com 
instead. If you feel you need more help with this, then do contact 
your Web Marketing Officer for assistance. 

 
 
For use with the ‘www Image with Caption’ template, images should be 218 pixels 
wide and 72 dpi. 
 

Using the Pixlr photo editor to resize images 
 
There is a handy web-based photo editor called Pixlr you can use to resize images. 
This does not require you to download software to your computer or purchase any 
kind of  licence to use it. 
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To open Pixlr, simply type the following address into your browser: 
http://pixlr.com/editor/  
 

 

 

Open your image by selecting ‘Open image from computer’  in the initial popup 
panel that displays (or select File > Open image ... and browse to your chosen 
image on your computer). 
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Go to Image  (in the top menu bar) > select the Image Size tool from the top menu to 
resize the image to the dimensions you need.  
 

 

 

In the popup that opens, ensure that ‘Constrain proportions’  is ticked. 
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Type ‘218’ into the box for the Width  – this is the correct width for any image for use 
in a www Image with caption template. The Height  figure will automatically change 
to retain the original proportions of the image. 
 

 

 

Click OK. Your image will reduce in size.  
 

 

 

If it looks very small, check the bottom left hand corner of the window in which the 
image appears, increase the percentage to 100% and press Return . The image 
will now appear at its actual size. 
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Go to File > Save  the image and optimise using the Quality  setting at around 75 by 
adjusting the slider to around this number.  
 

 

 

If you need any assistance, try the Help  menu (there are video tutorials, a forum and 
FAQs). 
 
 
 


